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VYBRANE PARAMETRY DOKUMENTU

Format stranky
Pouzivame standardni format stranky A4 (210 x 297 mm).

Okraje stranky

Levy okraj stranky: 3,5 cm

Horni, dolni a pravy okraj stranky: 2,5 cm

Tyto okraje se vztahuji na text a vSechny objekty (tabulky, grafy, schémata, ilustrace,
fotografie atd.). Zahlavi (pata) stranky mulize byt umisténa mimo tyto okraje, ale ne blize nez
1,5 cm od horniho (dolniho) okraje stranky.

Tisk prace, vazba

Préice se tiskne jednostranné na papir s minimalni gramazi 80g/m?. Na &elni stran& vazby
(doporucujeme tzv. pevnou vazbu) uvadéjte nazev univerzity, fakulty a katedry, oznaceni
diplomova (bakalafska) prace, v dolni ¢asti rok obhajoby a jméno a piijmeni autora (vzor —
viz pfiloha 2). Na hibetu vazby bude uvedeno jméno a piijmeni studenta a rok obhajoby.

Rozsah prace
Rozsah textu vysokoskolskych kvalifikacnich praci (pocitano bez ptiloh) by se mél pohybovat
v intervalu 40—60 stran u bakaléaiskych a 60—100 stran u diplomovych praci.

Typ pisma

Pro zékladni text doporucujeme pouzit patkové proporciondlni pismo — nejlépe Times New
Roman. Pro nazvy (kapitol, podkapitol a oddili) zvolime vhodné bezpatkové pismo (napf.
Arial). Neproporcionalni patkové pismo (napt. Courier) se pouziva omezen¢ napt. pro nékteré
vystupy ze statistickych programu. U grafii mizeme pouZit i bezpatkové proporciondlni
pismo — vhodny je jiZ zminény Arial.

Velikost pisma

Velikost zakladniho pisma je 11 bodl. Vétsi velikost pisma je vhodna pro nazvy kapitol,
podkapitol a oddilt (viz dale). Mensi pismo mizeme pouzit u objektt (tabulek, grafii atd.)
vcetné jejich popiskill (viz dale) a u pozndmek pod ¢arou. V uvedenych piipadech je
doporucend minimalni velikost pisma 9 bod.

Vyzna€ovani textu

VyznaCovanim rozumime zvyraziovani nékterych diilezitych pojmu, pasazi v textu atd.
Nejvhodné;jsi zplisob pro vyznacovani textu je pouziti kurzivy, ptipadné i (polo)tué¢ného fezu
pisma. V zadném piipad¢ text nepodtrhadvame, jednd se o zasadni typografickou chybu.
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Zarovnani textu

Zakladni text v rdmci odstavce zarovnavame do bloku (k obéma okrajiim stranky).
Doporuceny zplisob zarovnani textu Casto generuje ,,deformaci mezer* v rdmci odstavce
(nestejné vzdalenosti mezi slovy). Tento problém mtizeme feSit zménou formulace textu nebo
upravou roztece mezi slovy — napft. v aplikaci MS Word: Format» Font» Character Spacing.
K levému okraji stranky miizeme zarovnévat ndzvy vsech Urovni textu, popisky u objekta,
poznamky pod ¢arou, seznam literatury (viz ptiloha 7) atd.

Radkovani

Vybér pisma a volba fadkovani je nejdalezitéj§im parametrem ovliviiujicim vzhled
dokumentu. Velikost fadkovani se stanovuje predevsim podle pouzitého druhu pisma. Pii
doporucen¢ velikosti pisma zdkladniho textu 11 bodii doporucujeme pouzit fadkovani 1,3.
Vetsi fadkovani jiz neplsobi esteticky. Mensi fadkovani (1,0) volime v téch ¢astech prace,
kde pouzivame mensi font (velikost pisma 10 nebo 9 bodu).

Oddéleni odstavcu

Odstavce vizudlné oddélujeme odsazenim prvniho fadku pomoci tabelatoru doprava o cca
0,6 cm (= tzv. odstavcova zarazka). V tomto piipad¢ je dulezité, aby posledni text odstavce
(tzv. vychodovy tadek) byl delsi nez je tato odstavcova zardzka, piipadné, aby tento fadek
m¢él na konci vzdéalenost vétsi od pravého okraje nez je odstavcova zardzka. Prvni odstavec
v kapitole (v podkapitole atd.) se neodsazuje!

Sirotci (orphans) a vdovy (widows)

Pti odstavcové sazb¢ textu se musime vyvarovat existence tzv. sirotkli (orphans) a vdov
(widows). Sirotkem rozumime stav, kdy posledni fadek odstavce je zaroveil prvnim fadkem
nasledujici stranky. Ve druhém ptipad€ je ivodni fadek odstavce zaroven poslednim fadkem
dané strany. Uvedeny problém mtzeme fesit riizn€ — preformulovanim, zkracenim nebo
doplnénim textu, upravou mezer atd.

Déleni slov; nedélitelné prvky textu

Pokud mozno nepouzivejme v praci déleni slov z divodu relativné slozité kombinace
pravopisnych a typografickych pravidel. Dllezité je vSak mit na paméti, ze existuje nékolik
nedélitelnych prvki (tzn. Ze je nemiizeme rozd¢lit, resp. ponechat samostatné na konci
fadku). Jedna se predevsim o:

* jednoznakové piedlozky a spojky (a, o, u, 1, k, v, s, z)

+ (islo a jednotka (100 kg)

+ (islo kapitoly, stranky, obrazku, tabulky atd. (obr. 3)

» datum (3. 5. 2007; 8. Cervence)

* jméno a ptijmeni (J. R. Wilmoth)

 titul a pfijmeni (prof. Wilmoth) atd.

Nede¢litelnost uvedenych prvki textu zabezpecime pomoci tzv. pevné (nezlomitelné) mezery.
(napt. v aplikaci MS Word ji vlozime klavesovou zkratkou Ctrl-Shift-mezernik).
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U dlouhych webovych adres se casto nevyhneme (pfi zarovnavani textu do bloku) jejich
rozdéleni na dvé ¢asti. Tyto adresy mizeme rozdé¢lit v mistech vhodnych znakt (napt. /, =
atd.), ale nedélime je uprostied textovych polozek.

Nadpisy kapitol (podkapitol atd.)

Jednotlivé trovné textu (kapitoly, podkapitoly atd.) odliSujeme velikosti pisma a tuénym
fezem. V nadpisech jednotlivych urovni textu pouzivame arabska ¢isla v desetinném tiidéni,
za poslednim ¢islem nevkladame tecku.

U nazvu vSech urovni kapitol se pouziva pismo Arial, fez pisma bold: u kapitol velikost
15 bodt, u podkapitol 13 bodi a u oddila 11 bodii. U prvni arovné (kapitola) se vlozi nad
vlastni ndzev slovo kapitola (velikost pisma 14 bodil) s pofadovym ¢islem (viz ptiloha 3).

Kapitola 1 (Arial, 14 pt)
Nazev kapitoly (Arial, 15 pt)

1.1 Podkapitola (Arial, 13 pt)

1.1.1 Oddil (Arial, 11 pt)

Nazev kapitoly se vzdy vklada na novou stranku. Nazev kapitoly obvykle nezac¢ind u horniho
okraje stranky, ale vklada se s ur¢itou mezerou, které fikame strankova zarazka a ktera musi
byt stejnd pro cely text (tzn. pro vSechny hlavni nazvy). Doporucujeme vkladat strankovou
zarazku ve vzdalenosti 7 cm od horniho okraje stranky. Jednotlivé urovné nadpist
oddélujeme od textu podle schématu uvedeného v ptiloze 3.

cvwr

obycejny text. Pak se kumuluji mezery definované pro ob¢€ urovné nadpist a zstava ptili§
mnoho prazdné plochy. V tomto piipadé€ nastavime u nadpisu vyssi irovné nulovou mezeru
pod timto nadpisem. Obdobn¢ postupujeme i u dalSich kombinaci.

Nézvy kapitol (podkapitol, oddili) zarovnavame k levému okraji stranky.

Cislovani stranek

Cisla stranek miizou byt umisténa na riznych mistech stranky véetné zahlavi nebo paty.
Doporucuje se jejich umisténi u pravého horniho okraje stranky (jako soucast zahlavi). Sazi
se obvykle stejnym pismem — nebo o 1 bod mensim pismem — jako zékladni text. Cislovani se
zacind od obsahu prace a pokracuje na vSech strankéach prace s vyjimkou tvodnich stranek
prace, které se necisluji, ale zapocitavaji se do celkového poctu stranek prace. Pro ¢islovani se
pouzivaji arabské cislice.
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Poznamky pod €arou (footnotes, endnotes)

Pozndmky pod Carou se nejcastéji vyskytuji ve formé tzv. footnotes (jsou umistény v paté
stranky). V tomto piipad¢ jsou nejcastéji oddéleny od textu vodorovnou ¢arou. Druhou
moznosti je jejich umisténi na konci kapitoly (prace) — jedna se o tzv. endnotes. Poznamky
pod Carou Cislujeme prubézné v celé praci. Odkaz na poznamku se vklada jako horni index
a umist’uje se za slovo, které¢ho se dana poznamka tyka. Pro poznamky pod ¢arou se pouziva
pismo, které je o 1-2 body mensi nez zakladni text; fadkovani nastavime na hodnotu 1,0

a text zarovname k levému okraji.

Zahlavi stranky

Zéhlavi se sazi menSim pismem nez zakladni text (o 1 az 2 body). Od vlastniho textu se
oddé€luje mezerou (napft. prazdnym fadkem) nebo jemnou vodorovnou ¢arou. Zahlavi se
nepouziva na strankach s objekty otocenymi o 90 stupiii. Doporucujeme vkladat tzv. nezivé
zahlavi, které se v textu prace neméni a obsahuje jméno autora a nazev prace.

Poradova sazba

Vyuziva se pti sazbé nadpisti, obsahi, rejstiikli a seznamii. Podfazenost v textu se oznacuje
Cislicemi a pismeny (pfipadné i jinymi znaky) v urcité posloupnosti. Kdyz oznacujeme potadi
pismeny, vkladaji se za velkymi pismeny (verzalkami) tecky: A. a za malymi pismeny
(minuskami) zadvorky: a) (nikdy ne oboji).

Pti vytvareni seznamu je vhodné respektovat i jazykovou stranku. V ptipadé, ze polozky
seznamu jsou nevétné, piSeme je s malym pismenem a oddélujeme carkami; za posledni
polozkou seznamu je tecka.

Jednim z ptikladti potadové sazby je obsah (viz priloha 4), ktery byva standardné zalomen do
dvou sloupcti: v prvnim sloupci se vkladaji nazvy cisla a ndzvy kapitol (a podkapitol, oddill),
ve druhém ¢islo pocatecni stranky. Oba sloupce jsou z diivodu lepsi orientace propojeny tzv.
vodicimi znaky (nej€astéji pouzivame tecky).

Objekty (tabulky, grafy, mapy, schémata, ilustrace, fotografie atd.)

Objekty pokud mozno umist'ujeme uvniti plochy na strdnce vymezené pro text. Vzdalenost
vSech objektli od textu by méla byt v celé praci stejnd. Obdobné musime dodrzet konstantni
vzdalenost mezi objekty a jejich popisky — viz pfiloha 3. V ptipad¢ kombinace objektu a textu
by mély byt na strance alespon tii fadky zakladniho textu, jinak objekt vkladame samostatné.

Objekty maji byt organicky umistény v textu, jenom v ojedin€lych piipadech se umistuji do
ptiloh. Odkazujeme na n€ na vhodném misté v textu. Objekty musi byt dostate¢né Citelné a ve
vhodné kvalité¢ — nepouzivame fotografie nebo obrazky z internetu v nizkém rozliSeni (pod
300 dpi). U vSech objekti musi byt uveden zdroj (s vyjimkou vlastni prace autora).

Nézvy objektl struéné a vystizné€ vyjadiuji jejich obsah, pfedevsim z hlediska vécného

vymezeni, ale mohou obsahovat i zdkladni vymezeni izemni nebo Casové.
Pro nazvy objektd se pouziva pismo, které je o 1 bod mensi ve srovnani se zakladnim
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pismem; pro zvyraznéni ndzvi mizeme vyuzit rizné fezy pisma (kurziva, (polo)tucné,
piipadné jejich kombinaci). Do nazvi vkladame ¢islo objektu, které umoznuje odkazovat

v textu. U viech grafickych objekti doporudujeme pouzivat v nazvech zkratku Obr. Cislovani
objektll musi byt v celém textu pritbézné. V legend¢ k objektim doporucujeme pouzit pismo,
které je jesté o bod mensi nez pismo popisk.

Tabulky

Pro formalni apravu tabulek doporu¢ujeme:

Siika tabulky je v optimalnim p¥ipad& rovna Siice okolniho textu; v piipadg, Ze neni,
umistime ji na stfed.

Tabulky se sazi stejnym pismem jako zakladni text, vétSinou vSak o 1 az 2 body mensSim.
Nazvy tabulek se sazi k levému okraji tabulky.

Pod tabulkou umist'ujeme poznamky, vysvétlivky a odkazy na literaturu. Velikost
pouzitého pisma je o 1 bod mensi nez je text v tabulce.

Tabulka by méla mit vice fadkd nez sloupct

,Dlouhé tabulky* (= delsi nez 1 strana) je mozno rozd¢lit na nékolik tabulek, potom se na
kazdé strance opakuje hlavicka této tabulky.

,.Siroké tabulky* (= $ir$i nez standardni Sitka sazeného textu) miizeme pootocit

0 90 stupiiti (umistit tzv. na $itku).

V tabulkach se oznacuje pomlckou (-) situace, Ze jev se nevyskytoval. Nula (0) znaci, ze
jde o c¢iselny udaj, ale jeho hodnota je mensi nez jedna polovina méfici jednotky pouZzité
v tabulce. Znak (x) pouzivame v tabulce tehdy, jde-1i o udaj, jehoz ¢iselné naplnéni neni
logicky mozné. Tecka (.) znamena, ze vyplnéni udaje je sice logicky mozné, ale v dobé
konecného zpracovani tabulky nebyl udaj znam, ptipadné byl nespolehlivy.

Pokud jsou ¢isla ve sloupci tabulky stejné dlouhd, miizeme je zarovnat na stred. Pti rizné
délce je zarovnavame k pravému okraji sloupce a vycentrujeme podle délky nejdelsiho
Cisla (viz ptiloha 3).

Textové udaje ve sloupci tabulky se zarovnavaji k levému okraji.

Dlouha ¢isla v tabulce zkracujeme pomoci mérnych jednotek: napt. misto 1 255 455
napiseme 1 255 a do zdhlavi sloupce uvedeme mérnou jednotku (v tis.).

V tabulkach zacinaji nazvy samostatnych oddili velkym pocatecnim pismenem, v dalsi
urovni nazvl byva pocatecni pismeno malé.

Grafy

Pro grafy pouzivame podobna pravidla jako pro Upravu tabulek. Dale doporucujeme:

Na vodorovnou osu se zaznamenava nezavisla promeénna, na svislou osu proménna
zavisla.

V kazdém grafu vkladame popisky os véetné oznaceni mérnych jednotek.

Jednotlivé proménné v grafu musi byt zietelné odliSeny, nejlépe pomoci riznych barev
nebo znacek (viz ptiloha 6).

Barvy (piedevsim podkladové) volime s citem.

U vSech objekti (v¢etné grafll) vkladame nazvy az v textovém editoru.
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Problematicka mista v sazbé textu

Mezera

* nutnost zamezit vyskytu nadbyte¢nych mezer mezi slovy

* mezeru nevklddame pted interpunkéni znaménko — Spatné ? vs. dobie?
* mezery neuzivame za a pred zavorkou — ( Spatné ) vs. (dobie)

* mezera je prili§ velka: napt. 1 500, 150 kW, 5. 10. 1998 (viz dale)

Spojovnik (divis)

Pouziva se jednak jako rozdélovnik na konci fadku, jednak je spojovnik v téchto ptipadech

(nikdy se neodd€luje mezerami):

» ve slozenych slovech — ¢esko-slovensky, socidlné-ekonomicky

* v nazvech uzemnich jednotek — Praha-vychod

» v soufadnych spojenich — propan-butan

* ve slozenych ptijmenich — Colloredo-Mansfeld

Pokud se spojovnik vyskytne na konci fadku, tak ho musime vlozit i na zacatek dalsiho fadku:
(Praha-

-vychod).

Pomlcka (en-dash)

Vkladame ji jako klavesovou zkratku Alt+0150. Pomlcka se pouziva ke vloZeni vsuvky do
véty (v tomto ptipadé se odd€luje z obou stran mezerami). Pomlcka také nahrazuje nékteré
piedlozky nebo spojky (napf. a, az, do, versus, proti) a v tomto piipad¢ se vklada bez mezer:
pracoval v letech 1940-1952

letecka linka Pafiz—Londyn

utkéni Bayern—Chelsea

otevieno Po—Pa

vekova skupina 20-24 let

V ptipadé, ze pomlcku pouzivame v aritmetickych vyrazech jako znaménko minus, vkladame
ji s mezerami (10 — 5 =4).

Uvozovky

Cestina pouziva jenom jedny uvozovky — ,.to jsou ¢eské uvozovky*. Dolni uvozovky miizeme
zapsat jako Alt+0132 a horni uvozovky jako Alt+0147. Jednoduché uvozovky — ,uvozovky* —
pouzivame uvnitt slozenych uvozovek a to ptredevsim v piipadé tzv. citace v citaci.

Lomitko

Lomitko se neoddéluje mezerami v Cislech, jednotkach, zlomcich — 1999/2000, m/s, %s.

V textu ho mizeme odd¢lit mezerami k oddéleni posloupnosti riznych polozek — Internet /
Elektronicka posta / World Wide Web / Gopher.
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Interpunkéni znaménka (te€ka, dvojtecka a trojtecka)

Na konci véty je vZzdy jenom jedna tecka, i kdyZ véta kon¢i zkratkou s te€kou. Tecka se
nikdy nevklada za nadpisy a na konci ¢iselného oznaceni kapitol, podkapitol a oddila
(podkapitola 3.1). Pokud je v zavorce cela véta, tak se teCka piSe do zavorky. Pokud je

v zavorce jenom cast vety, pise se teCka za zavorku. Dvojtecka se od ¢isel oddéluje mezerou
(pomér 5 : 3). Trojtecka je u modernich pisem samostatnym znakem. ZapiSeme ji klavesovou
zkratkou Alt+0133.

Krat
Znak pro nasobeni se vklada pomoci specialniho znaku x (vkladame ho ve Wordu z nabidky
Insert» Symbol» Symbols, font Symbol). NepouZiva se malé pismeno x.

Procento, promile (%, %)

Znak pro procento se:

* od ¢isla oddéluje mezerou (12 %; vyznam = dvanact procent)

+ za Cislem vklada bez mezery (12%; vyznam = dvandctiprocentni)
Znak pro promile (%o) se vklada jako Alt+0137.

Jednotky a ozna¢eni mény
Jednotky a oznaceni mény se od ¢isla odd€luji pevnou mezerou (12 kg, 125 K<) — vzdy musi
zlstat na stejném fadku.

Cisla, datum

V textu by véta neméla zacinat ¢islem. Pro desetinna ¢isla pouzivame desetinnou ¢arku.
Tisice a miliony se odd¢€luji pevnou mezerou (1 254 555). Také spravny zapis data obsahuje
pevné mezery (4. 4. 2007, 4. dubna 2007).

Zuzena mezera

V kvalitni sazbé miiZeme pouzit tzv. zaZenou mezeru, kterd je ve srovnani se standardni
mezerou uzsi. Pouziva se jako:

* odd¢lovac¢ miliont a tisict u ¢isel (1 543 258)

+ oddélovac mezi ¢islem a znakem pro procento (14 %)

» oddélovac dvojtecky od ¢isel (5 : 3)

» oddélovac polozek v datu (15.4.2007)

* odd¢lovac ¢isla a jednotky (156 kW)

Z0uzenou mezeru lze v aplikaci MS Word vlozZit z nabidky Insert» Symbol» Special

Characters»1/4 Em Space. Tato mezera vSak neni nezlomitelnd, proto ji miizeme pouzit jen
v ptipad¢, nehrozi-li v jeji blizkosti fadkovy zlom.
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PRILOHA 1

VZOR: LAYOUT DOKUMENTU



Arial, 14 pt, bold

Arial, 15 pt, bold

Jméno autora: Nazev prace  Times New Roman, 9 pt, italics 7
Format: A4 Okraje: levy — 35 mm, ostatni — 25 mm
Zakladni pismo: Times New Roman, 11 pt Zakladni radkovani: 1,3

Kapitola 1 7 cm od horniho okraje stranky (HOS)

9 pt
Mezinarodni migrace v Ceské republice v kontextu

evropskych integra¢nich proces
24 pt

Mezinarodni migrace obyvatelstva (zejména: ,,stavy a toky* divody/podminénosti, mechanizmy,
disledky) prosla v Cesku (Ceskoslovensku) za vice neZ jedenéct transformaénich let velmi
dynamickym vyvojem. Ctyfi pom&mé vzajemné odli§né etapy vyvoje migrace (blize viz Drbohlav,
2001) vrcholi soucasnym stavem. Pfes vSechna specifika pfedrevolucniho i transformacniho
obdobi, jsou dnes migra¢ni parametry Ceska, tak je tomu ostatné také napf. ve vyvoji politickych,
ekonomickych nebo demografickych struktur, v mnohém podobné tém, jez Ize nalézt ve vyspélych
zapadnich, zejména zapadoevropskych, demokraciich. Podobnost na poli migrace, jejiz vyznam
v Cesku neustale roste, je patrna ve dvou zakladnich rovinach: 1) Z hlediska samotné pfitomnosti
mezinarodnich migrantli na uzemi statu a 2) z hlediska obecnéjSich procestl, které mezinarodni

migraci vyvolavaji i trvale udrzuji v chodu.

6 mm<>K 31. 12. 2000 bylo oficialné na Gizemi Ceska evidovano 200 951 cizinct (povolené trvalé

Arial, 13 pt, bold

pobyty a viza k pobytu nad 90 dni, maximaln¢ vSak do 365 dni). To pfedstavuje cca 2 % domaci
populace. Podle dat z konce 90. let se podil cizincti napt. v Dansku, Francii, Irsku, Nizozemsku,
Svédsku, Velké Britanii, ale i Norsku pohyboval v rozmezi 3,0 az 6,3 % (Salt, 2000). Zahrnuti
pomérné vysokych odhadi ilegalné pobyvajicich cizinci na Gizemi Ceska (cca kolem 200 tis.) by
patrné maly rozdil nékde sniZilo nebo uplné vymazalo. Co se tyée poétu zadosti o azyl, Cesko
v absolutnim vyjadfeni v roce 1999 napt. vysoce predéilo Portugalsko, Recko i Finsko a jeho
podty zadatell o azyl v daném roce byly viceméné srovnatelné s Danskem, Irskem a Spanélskem
(Salt, 2000).

24 pt

1.1 Teoretické koncepty
12 pt

Moznosti ovéfeni migra¢nich teorii jsou v Cesku, jakoZ i v celém regionu transformujicich se zemi
sttedni a vychodni Evropy (SVE) zatim omezené. Diivodem je: 1) zatim kratka doba, ktera ub&hla
od pocatku transformace, resp. od nastoleni prirozenéjSiho migra¢niho prostredi/rezimu, 2) doposud
probihajici transformace, resp. neexistujici pIn¢ stabilizované standardné fungujici trzni prostredi,
stale do jisté miry ovlivitované dtisledky minulého Zivota ve specifickych spolecenskoekonomickych
strukturach (Wallace, Stola, 2001). I pfes tyto problémy je vSak ziejmé...
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Pti Siroké analyze migracni situace je krom¢ migracni reality a teorii nutny pohled na migracni

politiku (véetné nasledné prosazované praxe), jako na jednu z dnes i v Ceské republice kli¢ovych

15 pt

determinant mizinérodnich migracnich pohyb.
1.1.1 Vyvoj a charakter migracni politiky a migraéni praxe

Pfedem je nutnc? %ﬁraznit, 7e se migracni situace v Ceské republice méni, a to piedev§im
v kontextu politického a socioekonomického vyvoje jak v zapadoevropskych zemich, tak v ostatnich
transformujicich se zemich SVE. Rozhodujici vSak ptirozen¢ byla a je socioekonomicka situace
zemé doprovazena piislusnou migracni politikou a praxi. Velmi zjednoduSené Ize vyvoj popsat
nasledovné: V ramci porevolucni situace vstoupila v platnost (jesté federativni) nova migracni
legislativa, ve které rychlost ptfiprav a schvaleni dostala pfednost pfed kvalitou. Nedokonala
a liberalné pojata legislativa, doprovazena relativné prosperujici ekonomikou poloviny 90. let
a nadmiru liberalni migracni praxi podpofila pfiliv imigrantti, pfedevsim cizi pracovni sily. Rok
1997, kdy se na mnoha frontach projevily problémy ¢eské ekonomiky, znamena prelom v migracni
politice a praxi. Zfejmy je posun od liberalniho k restriktivnimu pfistupu. Zmensuje se prostor pro
operovani cizincil na ¢eském trhu prace, a to jak pfirozenymi, tak i uméle vyvolanymi bariérami.
Do jisté miry chaos na poli mezinarodni migrace byl v Cesku az do této doby zapfi¢inén piedevsim
nasledujicimi faktory: 1) Celkové podcenéni otazek spojenych s mezinarodni migraci (vlada,
parlament), dlouhé ptipravy neflexibilni legislativy, nefungujici regula¢ni mechanizmy, minimalni
mezirezortni spoluprace; 2) neexistujici vize, urcujici k cemu ma vyvoj mezinarodni migrace v zemi
sméfovat' (ucelend migracni strategie), nazirani migrace téméf vyluéné z pohledu ,,bezpe€nosti
statu; 3) prosazovana pasivni, ad hoc politika?;, 4) minimalni publicita migra¢ni problematiky,
nedostatek objektivnich informaci o migraci/migrantech jak odbornych, tak téch, prezentovanych
ve sdélovacich prostiedcich.

Od roku 1998 se situace ¢astecn¢ méni. Vrcholi pétileté ptipravy nové migracni legislativy
anové zakony — &. 326/1999 Sb., o pobytu cizincti na izemi CR a &. 325/1999 Sb. o azylu, vstupuji
k 1. 1. 2000 v ucinnost (blize viz niZze). Tim se naplnil hlavni cil, koordinované a systematicky
posilit kontrolu mezindrodni migrace (celkové zptisnéni rezimu) tak, jak to vyzaduji standardy
a pozadavky EU. Z iniciativy Odboru azylové a migra¢ni politiky MV CR se zfizuje Komise
ministra vnitra pro piipravu a realizaci politiky vlady CR v oblasti integrace cizincii a rozvoje
vztahti mezi komunitami. Diky praci komise vznika Koncepce integrace cizincti na izemi CR, ktera
se po svém schvaleni vladou (11. 12. 2000) stava zakladnim pilifem v oblasti integrace cizinct. Pro
rok 2001 dochazi k uvolnéni 20 mil. K¢ ze statniho rozpoctu a jejich prerozdéleni do vybranych
rezortl. Jsou urceny k podpoie vyzkumnych a organizacnich aktivit, spadajicich do vypsanych
»tématickych okruhi pro realizaci vetejnych zakazek na podporu aktivit v oblasti integrace cizincti
na uzemi CR*. I diky...

! Samotn4 prosazovana harmonizace s migra¢ni politikou a praxi EU a vyhlaSeny boj ilegalni migraci rozhodng
nepostacuji. Times New Roman, 9 pt

2 S nékterymi vyjimkami, predeviim velmi aktivnim a usp&&nym ptisobenim Odboru pro uprchliky a integraci
migrantd MV CR a nékterymi nevladnimi organizacemi. ~ Radkovani 1,0
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V nasledujici ¢asti se pfeneseme do obecnéjsi roviny hodnoceni vybranych migrac¢nich vztahi
s dbrazem na kvalitativni aspekty migrac¢niho procesu. Konkrétné jde o ovéfeni, zda vybrané
pravidelnosti znamé z prostiedi vyspélych imigracnich zemi plati rovnéz v soucasnych podminkach
Ceska. Testovany jsou hypotézy, které se dotykaji vzajemnych souvislosti mezi imigraci,
socioekonomickym vyvojem cilové zemée a subjektivnimi postoji majority vici imigracni minorité.

7 ot Times New Roman, 10 pt, bold, italics _
Tab. 6 — Zdkladni vybrané ukazatele mezindrodni migrace podle krajit CR, k 31. 12. 2000

Kraj TP/a TP/r V/a V/r TP+V/a | TP+V/r PP/a PP/r
Praha 12 710 10,74 44 873 37,90 57583 48,64 13916 11,75
Stredocesky 6 631 5,96 20362 18,29 26 993 24,25 6314 5,67
Jihocesky 2585 3,69 6177 8,83 8762 12,50 1830 2,62
Zapadocesky 7 548 8,82 11 804 13,79 19 352 22,60 1 854 2,17
Severocesky 10 580 8,96 11383 9,64 21963 18,60 3592 3,04
Vychodocesky 6 106 4,96 9437 7,67 15 543 12,63 4338 3,53
Jihomoravsky 8 268 4,04 17 277 8,43 25 545 12,47 4943 2,41
Severomoravsky 12 463 6,36 12 747 6,50 25210 12,86 3293 1,68

Pozndmky: Kraje (8 véetné Prahy) jsou sloZeny z okresi tak, jak tomu bylo (s vyjimkou nov€ vzniklého Jeseniku)
v ramci pfedrevoluéniho izemné-spravniho ¢lenéni zemé — viz poznamka pod Carou €. 3.

TP/a — trvalé pobyty cizinct (absolutné)

TP/r — trvalé pobyty cizincl (relativné — na 1 000 obyvatel stfedniho stavu v roce 2000 dané cilové jednotky)

V/a — viza k pobytu nad 90 dnti (absolutng)

V/r — viza k pobytu nad 90 dnti (relativné)

TP+V/a — trvalé pobyty cizincl a viza nad 90 dnii (absolutné) Radkovani 1,0

TP+V/r — trvalé pobyty cizinci a viza nad 90 dnii (relativng)

PP/a — pracovni povoleni cizincl (absolutné)

PP/r — pracovni povoleni cizinct (relativng)

Zdroj: Horakové, MacoRhova, 2001 a viastni vipocty.
7 pt
Pti ovéfovani hypotéz je nutné brat do tivahy nékolik existujicich problémti: 1) Ub&hlé

porevoluéni osmileté obdobi samostatné CR je pro vykrystalizovani trendt velmi kratké, a to
i proto, e mnohé zmény prichazeji s urditym asovym zpozdénim; 2) Cesko stale prochazi
transformac¢nim obdobim, a tedy standardni mechanizmy vyspélé svobodné demokracie se stale
buduji; 3) Kraje jsou v mnohém ohledu vnitiné velmi heterogenni celky, ale pro nedostupnost
podrobngjsich dat musi byt hodnoceny celkove; 4) 1 pres relativni spolehlivost vybéru vzorku
respondentl pii Setieni vefejného minéni, jehoz vysledky vyuzivame, dochazi na trovni kraja
k ¢aste¢nym ,,deformacim® struktur, resp. vyraznéj$im odchylkam od primeéru. I tato skutecnost by
mohla ¢aste¢né poznamenat charakter nékterych dosazenych vysledkd.

Ad 1: Hypotézu je mozno vicemén¢ potvrdit. Po rychlém padu v Gplném pocatku 90. let
prichazi obdobi relativné prudkého rtustu ¢eské ekonomiky (1993-1996 — napi. rast hrubého
domaciho produktu HDP — v roce 1994 2,2 %, 1995 5,9 % a 1996 4,8 %), které je doprovazeno
pomérné vyraznym nartistem ekonomické, pracovni imigrace (v tomto obdobi narostl pocet cizincti
s povolenym dlouhodobym pobytem z 46 070 na 152 767). Obdobi recese let 1997 az prvé
poloviny roku 1999 doprovazi vyznamny pokles ptilivu, resp. téZ u nékterych typt pokles stavii
ekonomickych migranti (napf. povoleni k zaméstnani poklesla z 61 044 na 40 312 v obdobi
31.12.1997-31. 12. 1999, Zivnostenska opravnéni ve stejném obdobi z 63 529 na 58 386). Ceska

ekonomika s realnymi ndznaky oziveni projevujicimi se vyznamnéji od roku 2000 (napft. posun...
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Nejvice k celkovému rozdilu tak neptispiva vékova skupina 20-29 let s vice nez trojnasobnou
nadumrtnosti muzi, ale skupina 60—-69 let, v niZ muzi umiraji ,,jen” dvakrat cast¢ji nez zeny
(obr. 6).

7 pt Times New Roman, 10 pt, bold, italics

Obr. 6 — Prispévky vékovych skupin ke zméné nadéje doZiti p¥i narozeni,
muZi, 1987-2000
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Obr. 6 — Prispévky vékovych skupin ke zméné nadéje doZiti pii narozeni,
muZi, 1987-2000
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Diichodovy systém CR: Implieitni-dafuvalena-napréaeiv preddichodovém

a duchodovém véku

®1zpt

Cilem této prace je analyzovat a zhodnotit zakladni pilii ¢eského diichodového systému z hlediska

Abstrakt

podnétii k setrvani na trhu prace ve vy$§im véku. Jako nastroj k tomu vyuziva ukazatele implicitni
dan€. V prvni ¢asti jsou popsany nékteré z konceptl implicitni dan€ a zplsoby jejich vyuziti.
Vypocty implicitni dané provedené v druhé ¢asti neukazuji zakonem stanovenou hranici pro odchod
do normalniho starobniho diichodu jako nejvyhodnéjsi vék pro ukonceni ekonomické aktivity. Byl
dokéazan vliv jak pohlavi, tak zlep$ujici se Girovné umrtnosti. Ctenafi se tak nabizi ukazka, jakym
zpusobem lze propojit poznatky dvou védnich obort, ekonomie a demografie. V samotném zavéru
je na zakladé¢ vysledkd citlivostni analyzy zpochybnéna spolehlivost implicitni dané jako nastroje

vhodného pro pouzitj v ramci hospodaiské politiky.
6 pt
Klicova slova: implicitni dan, dichodovy systém, pieddiichodovy a dichodovy vék, pracovni trh,

hospodaiska politika

Pension system in the Czech Republic: Implicit tax imposed on work in the
pre-retirement and retirement age

Abstract

The objective of this study is to analyse and to evaluate the prime pillar of the Czech pension
system with respect to the incentives on continued work in the old-age as a tool to measure this, the
implicit tax is being used. In the first part, some of the concepts of implicit tax and the ways of their
use are being explored. The calculations of implicit tax made in the second part do not support the
standard retirement age as the most advantageous age of the labour market withdrawal.
Furthermore, the impact of both the gender and the improving level of mortality has been proved.
In this thesis the connection between two scientific disciplines, economics and demography, is
illustrated. In the very end, the use of implicit tax as the tool in economic policy is discussed.
According to the results of the sensitivity analysis such application of implicit tax is impugned.

Keywords: implicit tax, pension system, pre-retirement and retirement age, labour market,

economic policy
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